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Getting Started with Kinetis SDK

(KSDK) v.1.2

1 Overview

Kinetis SDK (KSDK) is a Software Development Kit that
provides comprehensive software support for Freescale
Kinetis devices. The KSDK includes a Hardware Abstraction
Layer (HAL) for each peripheral and peripheral drivers built
on top of the HAL. Demo and driver example applications are
provided to demonstrate driver and HAL usage and to
highlight the main features of supported SoCs. Also, the
KSDK contains the latest available RTOS kernels, a USB
stack, and other middleware to support rapid development on
supported Kinetis devices. The image below highlights the
layers and features of the KSDK.

For supported toolchain versions, please reference the Kinetis
SDK Release Notes (document KSDK120RN).

For the latest version of this and other Kinetis SDK
documents, see the Kinetis SDK homepage
www.freescale.com/ksdk.
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Figure 1. KSDK layers

2 KSDK demo and example applications

The KSDK provides two classes of software examples:

* Demos Applications: Full-featured applications intended to highlight key functionality of a MCU, focusing on a
particular use case.
* Driver Examples: Simple applications intended to concisely illustrate how to use the KSDK’s peripheral drivers.

This section describes how the demo and driver example applications interact with other components of the KSDK. To get a
comprehensive understanding of all KSDK components and folder structure, see the Kinetis SDK API Reference
Manual(Document KSDK12APIRM).

Demo and driver example applications reside in folders that correspond to a specific board (<install_dir>/examples/
<board_name>). Within each board folder, there are folders containing sets of demo (demo_apps folder) and driver example
(driver_examples folder) applications. This document focuses primarily on demo applications because they are full-featured
applications. Everything that applies to driver demo applications is equally applicable to example applications.

When opening a board folder (<install_dir>/examples/<board_name>), this structure is observed:

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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. demo_apps — Board-specific demo applications
| driver_examples mmmmmmp Board-specific driver examples
__| {board_name}.peb — Processor Expert board configuration file

|| board.c —
|| board.h
__| gpio_pins.c
| gpio_pins.h
__| pin_mux.c

L) pin_mux.h

= Shared board-specific configuration/initialization
files

Figure 2. Board folder structure

At the top level of each board folder there is a common set of files used by the demos and driver examples. These files can be
modified to do operations such as changing the pin mux configuration. All board support files provided as part of the KSDK
are generated using reference *.peb file. These files are:

* board.c/h: The header file contains board-specific configuration macros for things such as debug terminal
configuration, push buttons, LEDs and other board-specific items. The C file contains clock and oscillator initialization

functions.

* gpio_pins.c/h: Definitions used by the KSDK GPIO driver for the platform’s GPIO pins. These include push buttons
and LEDs, but can include other items such as interrupt pins for external sensors, for example.

¢ pin_mux.c/h: Contains peripheral-specific pin mux configurations. These functions can be called by the
hardware_init() function or individually by the demo application.

¢ Processor Expert PEB file: Reference file for Freescale’s Processor Expert tool for the specific board.

Moving down to the demo_apps folder, a typical case will look something like this:

, adc_hw_tnigger e
adc_low_power

, dac_adc_demo

, flash_demo

| hello_world ===

. hwtimer_demo
i2¢c_comm

. 12¢_rtos

) lwip ——

. power_manager_hal_demo

, power_manager_rtos_demo

, rte_func

| armgcc —

. atl

, iar

) kds
, mdk

:-— Toolchain/IDE

project files

—

|| fsl_lptmr_irg.c
| hardware_init.c mmmm—p Demo-specific hardware initialization

— Demo main() function

L main.c

Figure 3. Demo Application folder structure
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2.1 Locating demo source files

When opening a demo or driver example application in any of the supported IDEs, there are a variety of source files
referenced. It is important to understand the location of these source files in the KSDK tree so that, if needed, they can be
copied or modified to help develop applications for custom hardware later on. Additionally, many files are shared and, if
modified, impact other demos. As a result, the user should have a full grasp of the KSDK structure to fully understand the
effect of manipulating the source files.

There are two other main areas of the KSDK tree used to provide the full source code for each demo application:

* <install_dir>/platform: Contains shared, SoC-specific linker files, startup code and source for KSDK HAL, peripheral
drivers, and system services.

* <install_dir>/lib: Contains the compiled library files of the KSDK platform components such as HAL, peripheral
drivers, startup code, and system services.

2.2 KSDK platform folder

The platform folder is the most important folder in the KSDK. It contains the “foundation” of the KSDK, and stores the
source code for the primary components including CMSIS header files, peripheral drivers, HAL, OS abstraction, startup,
system services and linker files. Building a demo application successfully requires a majority of these components.

When building a demo application that utilizes the KSDK platform components, two methods are possible: including
individual source files for each required piece (startup file, driver, etc.), or link in a library that contains all or relevant
components of the platform folder. All demo applications in the KSDK utilize the latter approach, choosing to provide a
library that contains all source code in the platform folder. This simplifies application development because it only requires
the include paths to be set correctly in the project files, as opposed to the user manually adding each file needed by the
application.

2.3 KSDK lib folder

Previous sections describe how the KSDK demo applications reference a library containing all components of the platform
folder. These library file projects reside in the KSDK top-level /ib folder in the ksdk_platform_lib directory.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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. ksdk_freertos_lib — armgce — |, KO2F12810
ksdk_hal_lib atl . K10D10
ksdk_mgx_lib iar K11DAS

. ksdk_platform_lib keds . K20D10

. ksdk_startup_lib mdk , KZ1DAS

. ksdk_ucosii_lib . K21FAl12

. ksdk_ucosiii_lib . K22F12810

K22F25612
. K22F51212

Figure 4. Lib folder

Each library configuration in the 1ib folder contains a folder for each supported toolchain. Each toolchain contains a folder for
the supported SoC families. The ksdk_platform_lib must be built for the specific SoC being used in the demo. This is
discussed in detail in the subsequent toolchain-specific sections.

3 Run a demo using IAR

This section describes the steps required to build, run, and debug demo applications provided in the Kinetis SDK. This
section also shows how to build the necessary library that the demos use. The hello_world demo application targeted for the
FRDM-K64F Freedom hardware platform is used as an example, although these steps can be applied to any demo or example
application in the KSDK.

3.1 Build the platform library

These steps show how to open the demo workspace in IAR Embedded Workbench, how to build the platform library required
by the demo, and how to build the demo application.

1. Open demo workspace in: <install_dir>/examples/<board_name>/demo_apps/<demo_name>/iar
The workspace file is named <demo_name>.eww, so for this specific example, the actual path is:
<install_dir>/examples/frdmk64f/demo_apps/hello_world/iar/hello_world.eww

After the workspace is open, two projects are shown: one for the KSDK platform library and one for the demo. Also,
the platform library project is bold, indicating that it is the active project. The active project can be changed at any time
by right clicking on the desired project and selecting “Set as Active” or via the build target drop-down at the top of the
workspace browser.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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Workspace x
kzdk_platform_lib - Debug -

Files
=Nl hello world

—& (J ksdk_platform_lib - Debug v
[(Josa

[ platform

[ Qutput

& (F hello_world - Debug v
(Jhoard

[(Jsaource

(] startup

[T utilities

[ Qutput

Figure 5. Workspace view
2. There are two project configurations (build targets) supported for each KSDK project:
* Debug - Compiler optimization is set to low, and debug information is generated for the executable. This target
should be selected for development and debug.
* Release - Compiler optimization is set to high, and debug information is not generated. This target should be

selected for final application deployment.

The tool allows you to select either the Debug or Release configuration on a per-project basis, but since the demo has a
dependency on the platform library, whichever configuration is selected for the demo must also be selected for the
platform library. Selecting a configuration in the drop-down also makes whichever project and configuration that is
selected the active project.

For this example, select the “ksdk_platform_lib — Debug” target.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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kzdk_platform_lib - Releaze
hello_world - Debug
hella_world - Releaze

| FEJosa

| & 3 platfarm
| @3 Output
L3 Fhello_world - Debug v
—& [ board

—&= (] source

—& [ starup

— [ utilities

—= (] Qutput

Figure 6. Platform library build target selection
3. Click the "Make" button, highlighted in red below.

: 2% hello_world - IAR Embedded Workbench IDE
File Edit View P‘n_:_jm Simulator Tunls_ Window He}p

0O a | & ]EEE E] s {“JI-I ..... £ :?\ %_-% g@@—“}ﬁ l}_I[ﬂEWI
Workspace 2
[ ksck_platform_b - Debug

Files .
2]

= [ ksdk_platform_lib - Debug  «
—&E (Josa

—= [ platform

—E ] Output

L& Fhello_world - Debug v
= [ board

—H (] source

— [ startup

—E (] utilities

—& (] Ourtput

Figure 7. Build the platform library
4. When the build is complete, the library (libksdk_platform.a) is generated in one of the following directories, according
to the chosen build target:

<install_dir>/lib/ksdk_platform_lib/iar/<device_name>/debug

<install_dir>/lib/ksdk_platform_lib/iar/<device_name>/release

3.2 Build a demo application

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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The KSDK demo applications are built upon the software building blocks provided in the Kinetis SDK platform library, built
in the previous section. If the platform library is not present, the linker displays an error indicating that it cannot find the
library. An easy way to check whether the library is present is to expand the Output folder in the ksdk_platform_lib project.
If the platform library binary is not built and present, follow the steps in Section 3.1 to build it. Otherwise, continue with the
following steps to build the desired demo application.

1. If not already done, open the desired demo application workspace. Demo application workspace files can be located
using the following path:

<install_dir</examples/>board_name>/demo_apps/<demo_name>/iar
Using the FRDM-K64F Freedom board as an example, the hello_world workspace is located in this folder:
<install_dir>/examples/frdmk64f/demo_apps/hello_world/iar/hello_world.eww

2. Select the desired build target from the drop-down. For this example, select the “hello_world — Debug” target.
Warkspace x

ihelln:n wiarld - Del:nua vi

kzdk_platform_lib - Debug

kzdk, Elatfurm ib - Releasze

hello_world - Releaze
I L !FH-CIL-IF\_I\JILMIUIIII_III\J I_p'El\_lLvll:l —

L= (F hello_world - Debug v
—# [ hoard
—& [ source
—& [ startup
— [ utilities
— [ Cutput

Figure 8. Demo build target selection
3. To build the demo application, click the “Make” button, highlighted in red below.

:E"i hello_world - IAR Embedded Workbench IDE
File  Edit View Project CMSI5-DAP Tools Window Help

p—
TR ’ r oy oy T
D@ & @ .o o ~ Y euEe &L d0H| Y
Workspace * | hello_worid.c |
Ihio_mld-{)ahp__ bt 11 * o Redistributions in binary form must reproduct
Files 1 B 12 # lisk of conditions and Ehe following disclais
13 * obthayr matsrials providsd vikth the distribubic
=) & hello_world -- 14 .
Hﬁkﬁdk_lﬂﬂ'fﬂrm lib - Debug 15 * o Neither the name of Freescale Semiconductor,
I—Eﬂhﬂllﬂ_ﬂ"ﬂﬂd Debug ¥ ié * contributors may be used to endorsze or promoi
(O board . 17 * goftyars vitheut spacific pricr written parm:
[ source . 18 .
:Iﬁtﬂﬂup . 19 * THIS SOFIWARE IS5 FROVIDED BY THE COPYRIGHT HOLI
& C utilities . 20 * ANY EXPRESS OR IMPLIED RARRANTIES, INCLUDING, |
LE'FL_'IUUtpUt 21 * FARRANTIES OF MERCHANTABILITY AND FITNESS FOR J

Figure 9. Build the demo application

4. The build will complete without errors.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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3.3 Run a demo application

To download and run the application, perform these steps:

1. Reference the table in Appendix B to determine the debug interface that comes loaded on your specific hardware
platform.
* For boards with CMSIS-DAP/mbed/DAPLink interfaces, visit developer.mbed.org/handbook/Windows-serial-
configuration and follow the instructions to install the Windows® operating system serial driver.
* For boards with P&E Micro interfaces, visit www.pemicro.com/support/downloads_find.cfm and download the
P&E Hardware Interface Drivers package.
¢ For the MRB-KWO1 board, visit www.freescale.com/USB2SER to download the serial driver. This board does
not support OpenSDA, so an external debug probe (such as a J-Link) is required. Steps below referencing
OpenSDA do not apply as there is only a single USB connector for serial output.
2. Connect the development platform to your PC via USB cable between the OpenSDA USB connector (may be named
OSJTAG for some boards) and the PC USB connector.
3. Open the terminal application on the PC, such as PuTTY or TeraTerm, and connect to the debug COM port (to
determine the COM port number, refer to Appendix A). Configure the terminal with these settings:
a. 115200 or 9600 baud rate, depending on your board (reference BOARD_DEBUG_UART_BAUD variable in
board.h file)
b. No parity
c. 8 data bits
d. 1 stop bit

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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Category:

&)+ Session Basic options for your PuTTY session |
L.ngg'rng Specify the destination you want to connect to

=~ Terminal

i Serial line Speed
- Keyboard T
- Bel COM16 115200

i - Features nection type:

= Window (")Raw () Telnet ) Rlogin () SSH I @ Serial
ﬁppea. Load, save or delete a stored session
L. Behaviour
L Translation Saved Sessions

.~ Selection Debug

- Default

& Comnecton Y —
[ P
-~ Rlogin
- SSH
- Sesial Close window on exit:

() AMways ( Never @ Onlyon clean exit
[ ot || Hep | [ open || Cancel |

Figure 10. Terminal (PuTTY) configuration
4. Click the "Download and Debug" button to download the application to the target.

Yy erdh US|
Figure 11. Download and Debug button

5. The application is then downloaded to the target and automatically runs to the main() function.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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S22 LELZIX
Workspace * helle_world.c
|hE"D_WDf|d-De|I'UEI v| 36  #include <stdio.h>
EilErs £ | B2, zz #include <stdlib.h>
B Ehello_world 39 // SDE Included Files
& G ksdk_platform_lib - Debug v 10 #include "board.h"
LE‘ (@ hello_world - Debug v 41 #include "f£31_debug conscle.h™
(O board 42
(1 zource 43
(3 startup 44 // Code
[ utilities AS  JSSIRIIIIIIEIIIIEFIGFEIFIIFEIIRTIEEIIEIEGPI0 87
3 Ot 48
47 0 /*!
48 # @hrief Main function
43 = =/
g 50 int main (woid)
51 |
52 /4 R¥ buffers
53 A4 Bparam receiveBuff Buffer used to hold rece
54 uintd_t receiveBuff;

Figure 12. Stop at main() when running debugging

6. Run the code by clicking the "Go" button to start the application.

— = 223
x/'| Elxﬁbﬁdux
LS

Figure 13. Go button
7. The hello_world application is now running and a banner is displayed on the terminal. If this is not the case, check your
terminal settings and connections.

Figure 14. Text display of the hello_world demo

4 Run a demo using Keil® MDK/uVision®

This section describes the steps required to build, run, and debug demo applications provided in the Kinetis SDK. This
section also shows how to build the necessary library that the demos use. The hello_world demo application targeted for the
FRDM-K64F Freedom hardware platform is used as an example, although these steps can be applied to any demo or example
application in the KSDK.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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4.1 Install CMSIS device pack

After the MDK tools are installed, Cortex® Microcontroller Software Interface Standard (CMSIS) device packs must be
installed to fully support the device from a debug perspective. These packs include things such as memory map information,
register definitions and flash programming algorithms. Follow these steps to install the appropriate CMSIS pack.

1. Open the MDK IDE, which is called puVision. In the IDE, select the “Pack Installer” icon.

kA uVision

File Edit WView Project Flash Debug Peripherals Tools 5V Window
&S A S| | | | | EEE N
| % | | &2 e ~@

Figure 15. Launch the Pack installer
2. In the Pack Installer window, navigate to the section with the Kinetis packs (they are in alphabetical order). The Kinetis
packs start with “Keil::Kinetis” and are followed by the MCU family name, for example “Keil::Kinetis_K60_DFP”.
Because this example uses the FRDM-K64F platform, the K60 family pack is selected. Click on the “Install” button
next to the pack. This process requires an internet connection to successfully complete.

@ Pack Installer

File Packs Window Help
e i

% | Device:

4] Packs | Examples |

Pack Action Description

+ - Keil:Kinetis_E60_DFP reescale Kinetis K60 Series Device Support and Examples

Figure 16. Install Kinetis pack

3. After the installation finishes, close the Pack Installer window and return to the puVision IDE.

4.2 Build the platform library
These steps show how to open the demo workspace in pVision, how to build the platform library required by the demo, and
how to build the demo application.
1. Demo workspace files can be found using this path:
<install_dir>/examples/<board_name</demo_apps/<demo_name>/<toolchain>
The workspace file is named <demo_name>.uvmpw. For this specific example, the actual path is:
<install_dir>/examples/frdmk64f/demo_apps/hello_world/mdk/hello_world.uvmpw

After the workspace is open, two projects show up: one for the KSDK platform library, and one for the demo. By
default, the demo project is selected as the active project.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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Project n (8]

E-5== WorkSpace
=125 ksdk_platform_lib
. @57 ksdk_platform_lib Debug
E| g hello_world
EE hello_werld Debug
F-{77 utilities
--1:| startup
--1:| SOUFCE
--1:| board

Figure 17. Workspace view
2. Make the platform library project the active project since the library is required by the demo application to build. To
make the platform library project active, right click on it and select “Set as Active Project”. The active project has a
black box around the project name. After it is active, the platform library project is highlighted.

Project 2 & Project 2 B
B WorkSpace B-‘= WorkSpace
D BN ek g amahasistive Ricieche i) @4 ksdk_platform_lib Debug
BB helio_world - B-&5 hello world
24 hello_world Debug E1-53 hello_world Debug
B3 utilities @7 utilities
E| {7 startup Fj| startup
{3 source E_‘| source
®-{Z7 board i3 board

Figure 18. Make the platform library the active project
3. There are two project configurations (build targets) supported for each KSDK project:
¢ Debug — Compiler optimization is set to low, and debug information is generated for the executable. This target
should be selected for development and debug.
* Release — Compiler optimization is set to high, and debug information is not generated. This target should be
selected for final application deployment.

The tool allows selection of the build target based on the active project, so in order to change the configuration for the
platform library it must be the active project. Choose the appropriate build target: “Debug” or “Release” from the drop-
down menu.

For this example, select the “ksdk_platform_lib Debug” configuration.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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File Edit WView Project Flash Debug Peripherals Tools SVCS Window Help

I“lﬁﬂﬂw —.jlﬂ.|'-'? o | :JL:|T“?1?1T§ EEE |

: - % ksdk platF:er lib Debug
B3 hello_world

E% hello_world Debug
-7 utilities
B0 startup
--% SOuUrce
-7 board

Figure 19. Platform library build target selection
4. Rebuild the project files by left-clicking the “Rebuild” button, highlighted in red.

\;’5 # [:QI fﬁl ksdk_platform_ IlhI}ebu;. f«.l & % ’ Q m
Project L)

E]E WorkSpace

. @i ksdk_platform_lib Debug
55 hello_world
=-523 hello_world Debug
-] utilities
m@ startup
-7 source
{7 board

Figure 20. Build the platform library

5. When the build is complete, the library (libksdk_platform.lib) is generated in this directory according to the build
target:

<install_dir>/lib/ksdk_platform_lib/mdk/<device_name>/debug
<install_dir>/lib/ksdk_platform_lib/mdk/<device_name>/release

4.3 Build a demo application

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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The KSDK demo applications are built upon the software building blocks provided in the Kinetis SDK platform library, built
in the previous section. If the platform library is not present, the linker displays an error indicating that it cannot find the
library. If the platform library binary is not built and present, follow the steps in Section 4.2 to build it. Otherwise, continue
with the following steps to build the desired demo application.

1. If not already done, open the desired demo application workspace in:
<install_dir>/examples/<board_name>/demo_apps/<demo_name>/mdk
The workspace file is named <demo_name>.uvmpw, so for this specific example, the actual path is:
<install_dir>/examples/frdmk64f/demo_apps/hello_world/iar/hello_world.uvmpw

2. Make the demo the active project.

Project n Project 2 B
El-5= WorkSpace El-— WorkSpace
EHE h:sdk_platfc-rm_lil:- @3 ksdk_platform_lib
= ’—_',; _Io_wpr_l P = 3 hello_world
= ,,J hello_w G - =223 hello_world Debug
B3 utilities E-7 utilities
m-{] startup ({3 startup
M- source ({73 source
@-{Z7 board E-EZ37 board

Figure 21. Make the demo project the active project
3. To build the demo project, select the "Rebuild" button, highlighted in red.

I.LJ E@ | 'ﬁf | hello_world Debug E ﬁt:\|

Figure 22. Build the demo

4. The build will complete without errors.

4.4 Run a demo application

To download and run the application, perform these steps:

1. Reference the table in Appendix B to determine the debug interface that comes loaded on your specific hardware
platform.
¢ For boards with the CMSIS-DAP/mbed/DAPLink interface, visit mbed, search for handbook/Windows-serial-
configuration, and follow the instructions to install the Windows operating system serial driver.
* For boards with a P&E Micro interface, visit www.pemicro.com/support/downloads_find.cfm and download and
install the P&E Hardware Interface Drivers package.
¢ For the MRB-KWO01 board, visit www.freescale.com/USB2SER to download the serial driver. This board does
not support the OpenSDA. Therefore, , so an external debug probe (such as a J-Link) is required. Steps below
referencing the OpenSDA do not apply asbecause there is only a single USB connector for serial output.
¢ For boards with the OSJTAG interface, install the driver from www .keil.com/download/docs/408.
2. Connect the development platform to your PC via USB cable between the OpenSDA USB connector (may be named
OSJTAG on some boards) and the PC USB connector.
3. Open the terminal application on the PC, such as PuTTY or TeraTerm, and connect to the debug serial port number (to
determine the COM port number, refer to Appendix A). Configure the terminal with these settings:

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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a. 115200 or 9600 baud rate, depending on your board (reference BOARD_DEBUG_UART_BAUD variable in

board.h file)
b. No parity
c. 8 data bits
d. 1 stop bit
Category:
- Session Basic options for your PuTTY session |
Lpggmg Specify the destination you want to connect to
= Teminal
i Senal line Speed
- Keyboard —
- Bel COM16 115200
i Features nection type:
= Window )Raw () Telnet () Rlogin ) SSH I @ Seqal
xea. Load, save or delete a stored session
i aviour
L. Translation Saved Sessions
- Selection Debug
‘ ﬂhll'ﬁ s Y .
- Default
& Connection Y R —
|- P [ Seve |
i~ Hlogin
- SSH
" Serial Close window on exit:
() Mways () Never @ Onlyon clean exit
[ Mot | e | [ Open [ Concel |

Figure 23. Terminal (PuTTY) configurations

4. After the application is properly built, click the "Download" button to download the application to the target.

i

Project

£ v] &R

[ Download

hello_waorld Debug

B WoerkSpace
{7 ksdk_platform_lib
iRy hello_world

Download code to flash memory

5. After clicking the “Download” button, the application downloads to the target and should be running. To debug the

Figure 24. Download button

application, click the “Start/Stop Debug Session” button, highlighted in red.
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Registers a Disassembly

Register | Value | 0r00001844 EQOO DCwW OREQQO

= Core 57k hardware_init(}:

: S8
s RO (00001340
- GcIFEFO028 ig // Call this function to initialize the console

~R2 00000000 // mnables the use of STDIO functions (printf, =

R3 Gc00000FES E{)QXUUOO:IB'QC F7FFFFBA BL.W hardware init (0x000017C4
R4 D000 TAED = A1 Aher mart init iy -

B 0<00001AED — :

~ R6 Qc00000000 (*] startup_MK22F51212;5  f]_hello_worid.c

i R 0000000 50 int main (void)

i R8 (cDDO0D000 514

- R9 (10000000 52 // RX buffers

: R10 (00000000 53 //!' Bparam receiveBuff Buffer used to hold recei
: R11 00000000 E4 uint® t receiveBuff:

R12 00000000 55 o

| [ RI13(5F) (520010000 56 // Initimlize standard SDK demo application pins
i 4R (00000405 M s7 hardwarze init():

- R 15 (PC) B0000184C 58 -

Ii o (61000000 53 /¢ Call this function to initialize the console
B

Banked &0 // enables the use of STDIC functioms (primtf, s
System 61 dbg uwart init():
Hode 'I'I'lread 63 // Print the initial banner
- Pavilege Privileged 64 PRINTF ("\r\nHello World!\n\n\zr");
i Stack MSP 65
" Stakes 22304 66 while (1)
: Sec 0.00228040 6710 g
® - FPU [1:] S/ Main routine that simnly echoes receiwved

Figure 25. Stop at main() when run debugging

6. Run the code by clicking the “Run” button to start the application.

o »oe e o

Registers — n_
— Run (F5)
Register Start code execution

RO (<00000965
R1 (b 1FFFD44(]

Figure 26. Go button

The hello_world application is now running and a banner is displayed on the terminal. If this is not the case, check your
terminal settings and connections.
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Figure 27. Text display of the hello_world demo

5 Run a demo using Kinetis Design Studio IDE

This section describes the steps required to configure Kinetis Design Studio (KDS) IDE to build, run, and debug demo
applications and the necessary libraries provided in the KSDK. The hello_world demo application targeted for the FRDM-
K64F Freedom hardware platform is used as an example, though these steps can be applied to any demo or example
application in the KSDK.

5.1 Select the workspace location

The first time that KDS IDE launches, it prompts the user to select a workspace location. KDS IDE is built on top of Eclipse,
which uses workspace to store information about its current configuration, and in some cases, source files for the projects in
the workspace. The location of the workspace can be anywhere, but it is recommended that the workspace be outside of the
KSDK tree.

5.2 Install Eclipse update

Before using KDS IDE with KSDK, the KSDK Eclipse Update must be applied. Without this update, Eclipse cannot generate
KSDK-compatible projects.

5.2.1 Windows operating system instructions and Mac® OS
instructions

NOTE
The steps required for Mac OS are identical to those for the Windows operating system.
The only difference is that the IDE looks slightly different.

To install the update, follow these instructions:

1. Select "Help" -> "Install New Software".

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015
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Fie Edit Sousce Refsctor Navigate Sesrch Project Protessor Bxpet Run  Windew [Help |

= e, | (®
& l'gi' Welcome 32 |b,;| Wielcome
7 (¥} Help Contents
5 Search
Dymamiz Help
Ky Assirt CtrleShifts L

Welcome to Kinetis Design | =™

i FReport Bug or Enhancerment...

Cheat Sheets..,
Overview Eclipse Marketplace..,
Get an overview of the features Check for Updates

Install Mew Software... |

Figure 28. Install new software
2. In the Install New Software dialog box, click the "Add" button in the upper right corner. Then, in the Add Repository
dialog, select the "Archive" button.

I Available Software r__| |

Select a site or enter the location of & site. o i —

Work with:  type or select a site B Add... I
Find more software by working with the "Available Softw

type filter text

i kame Version

T () There is no site selected. r.“. Add Repository “

Marne:

Location:  hitped/

(&)
WS

| seectal || Deseiectal | |

Figure 29. Add repository for new software
In the Repository archive dialog box, browse the KSDK install directory.
Enter the <install_dir>/tools/eclipse_update folder and select the KSDK_<version>_Eclipse_Update.zip file.
Click "Open", and the "OK" button in the Add Repository dialog box.
The KSDK update shows up in the list of the original Install dialogs.

AN
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Install
Available Software |
Check the items that you wish to install. ,:;‘1:
Work withe | jar:file:/media/psfiHome/Documents/Sandbox fKSDE_1.2.0_RC3/tools/eclipse_update/KSDE_1.2.0_Eclipse_Update.zip -~ Add...

Find more software by working with the "Available Software Sites” preferences.

Name Version
< 111 KSDK 1.2.0 Eclipse Update

Figure 30. Select the Eclipse update
7. Check the box to the left of the KSDK Eclipse update and click the "Next" button in the lower right corner.
8. Follow the remaining instructions to finish the installation of the update.

After the update is applied, restart the KDS IDE for the changes to take effect.

5.2.2 Linux® OS instructions

The following instructions were performed using Ubuntu 14.04. These steps may be slightly different for other Linux
distributions.
To install the update, follow these instructions:

1. Launch KDS IDE from the command line as the root user. On the command line, use this command, assuming the
default KDS IDE install path: user@ubuntu:~$ sudo /opt/Freescale/KDS x.x.x/eclipse/kinetis-
design-studio

The KDS IDE version (shown above as x.x.x) should reflect the version installed on your machine, for example, 3.0.0.

2. You are prompted to enter the root password.
3. Select "Help" -> "Install New Software".

C/C++ - Kinetis Design Studio

File Edit Source Refactor Navigate Search Project Processor Expert Run Window Help
i ' A Qo FTE TR ‘& v &Y v [&f * G ¢ Welcome i
Help Contents
< Search |
[ty Project Explorer 2 = O Dynamic Help

= Key Assist... Shift+Ctrl+L
Tips and Tricks...
Report Bug or Enhancement...
Cheat Sheets...

Eclipse Marketplace...

Check For Updates
Install New Software...

About Kinetis Design Studio

Figure 31. Install new software
4. In the "Install New Software" dialog box, click the "Add" button in the upper right corner. Then, in the "Add
Repository" dialog, select "Archive".
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Find more software by working with the “Available Software Sites” preferences.
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(L) There is no site selected,
™ Add Repository

Mame; ' Local..

Location: hetp:ff

Select All D ._’_f‘f;

-

Canced

Figure 32. Add repository for new software
In the Repository archive dialog box, browse the KSDK install directory.

Enter the <install_dir>/tools/eclipse_update folder and select the KSDK_<version>_Eclipse_Update.zip file.
Click "Open", and "OK" in the "Add Repository" dialog box.
The KSDK update shows up in the list of the original Install dialogs.

® N

& Install

Available Software

Check the items that you wish to install.

Work with:  jarfile:/C:/Freescale/KSDK_1.2.0/tools/eclipse_update/KSDK_1.2.0_Eclipse_Update.zip!
Find more softw

type filter text

Name Version
. [¥] 000 KSDK 1.2.0 Eclipse Update

Figure 33. Select the Eclipse update
9. Check the box to the left of the KSDK Eclipse update and click the "Next" button in the lower right corner.
10. Follow the remaining instructions to finish the installation of the update.
11. After the update is applied, restart the KDS IDE for the changes to take effect.
12. After KDS IDE restarts, shut down the IDE and restart by launching KDS IDE as the non-root user. To do this, follow
the command in step 1, only without the "sudo" command.
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5.3 Build the platform library

These steps show how to open and build the platform library project in KDS IDE. The platform library is required by the
demo and does not build without it.

NOTE
The steps required for the Linux OS and Mac OS are identical to those for the Windows
operating system. The only difference is that the IDE looks slightly different.

1. Select "File->Import" from the KDS IDE menu. In the window that appears, expand the "General" folder and select
"Existing Projects into Workspace". Then, click the "Next" button.

3 et 5, e |
Select .,
Create new projects lrom an archive Tile or directory. el |
Gelect an import tounce:

& [ Genedal -
s g File
cb Exxsting Pregects into Workspace

e Sy AL

T, Preferences
CiCas
Component Development Eraromnment
s

Oat

Inatall

Procenzor Expart
Remote Systams
RFEA

R, Dhebug

T

Figure 34. Selection of the correct import type in KDS IDE

2. Click the "Browse" button next to the "Select root directory:" option.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015

Freescale Semiconductor, Inc.



h

{ . ___________________________________________________________________________4

Run a demo using Kinetis Design Studio IDE

% Import [EEEEy=>=
Import Projects s
Select a directory to search for existing Eclipse projects. [ 'l

@ Select roct directory: =

Select prehive file:

Projects:
' [ gelect Al
| Deselect Al
[ Rafresh
Options
Search for nested projects
Copy projects into workspace
Working sets
Add project to working sets
(7 losBack |  He Fir | Concel

Figure 35. Projects directory selection window
3. Point to the platform library project for the appropriate device, which can be found using this path:

<install_dir>/lib/ksdk_platform_lib/kds/<device_name>
For this example, the specific location is:
<install_dir>/lib/ksdk_platform_lib/kds/K64F 12

4. After pointing to the correct directory, your "Import Projects" window should look like the figure below. Click the
"Finish" button.

NOTE
Do not select the "Copy projects..." option.
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| Refresh
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Figure 36. Select K64F12 platform library project
5. There are two project configurations (build targets) supported for each KSDK project:

* Debug — Compiler optimization is set to low, and debug information is generated for the executable. This target
should be selected for development and debug.

¢ Release — Compiler optimization is set to high, and debug information is not generated. This target should be
selected for final application deployment.

6. Choose the appropriate build target, "Debug" or "Release”, by clicking the downward facing arrow next to the hammer
icon, as shown below. For this example, select the "Debug" target.
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File Edit 5Source Refactor Mawvigate 5Search Project
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v 1 Debug
2 Release
L Project Explorer 53
|

- I=5 ksdk_platform_lib_K64F12

Figure 37. Selection of the build target in KDS IDE

The library starts building after the build target is selected. To rebuild the library in the future, click the hammer icon
(assuming the same build target is chosen).

5.4 Build a demo application

To build a demo application, repeat the steps listed in Section 5.3, using a demo application project instead of the platform
library project. Demo application projects are located in this folder:

<install_dir>/examples/<board_name>/demo_apps/<demo_name>/kds
For this example, the path is:

<install_dir>/examples/frdmk64f/demo_apps/hello_world/kds

5.5 Run a demo application

NOTE
The steps required for the Linux OS and Mac OS are identical to those for the Windows
operating system. The only difference is that the IDE looks slightly different. Any
platform-specific steps are listed accordingly.

To download and run the application, perform these steps:

1. Reference the table in Appendix B to determine the debug interface that comes loaded on your specific hardware
platform.
» For Windows operating system and Linux OS users, download the driver that corresponds to your debug
interface:

- For boards with the CMSIS-DAP/mbed/DAPLink interface, visit developer.mbed.org/handbook/Windows-
serial-configuration and follow the instructions to install the Windows operating system serial driver. If running
on Linux OS, this step is not required.

- For boards with a P&E Micro interface, visit www.pemicro.com/support/downloads_find.cfm and download
and install the P&E Hardware Interface Drivers package.

- If J-Link is used, either a standalone debug pod or OpenSDA, visit www.segger.com/jlink-software.html.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015

Freescale Semiconductor, Inc. 25



http://developer.mbed.org/handbook/Windows-serial-configuration
http://developer.mbed.org/handbook/Windows-serial-configuration
http://www.pemicro.com/support/downloads_find.cfm
https://www.segger.com/jlink-software.html

h

rnun a demo using Kinetis Design Studio IDE

- For the MRB-KWO01 board, visit www.freescale.com/USB2SER to download the serial driver. This board does
not support OpenSDA, so an external debug probe (such as a J-Link) is required. Steps below referencing
OpenSDA do not apply as there is only a single USB connector for serial output.

* For Mac OS users, KDS only supports the J-Link OpenSDA interface.

- Follow the instructions in Appendix C to update your board's OpenSDA interfacet o the J-Link OpenSDA
application. Then, visit www.segger.com/jlink-software.html to download the necessary software and drivers.

2. Connect the development platform to your PC via USB cable between the OpenSDA USB connector (may be named
OSJTAG for some boards) and the PC USB connector.

3. In the Windows operating system environment, open the terminal application on the PC, such as PuTTY or TeraTerm,
and connect to the debug serial port number (to determine the COM port number, refer to Appendix A). For Linux OS,
open your terminal application and connect to the appropriate device.

Configure the terminal with these settings:

a. 115200 or 9600 baud rate, depending on your board (reference BOARD_DEBUG_UART_BAUD variable in

board.h file)
b. No parity
c. 8 data bits
d. 1 stop bit
2 PuTTY Configuration
Category:
[=- Session Basic options for your PuTTY session |
i T-" Lpg?ing Specify the destination you want to connect to
==
& Senal Iine Speed
- Keyboard .
- Bel COM16 115200
- Features onnection type:
=- Window VRaw () Telnet ¢ Rlogin () S5H | @ Seqal
3 :::EE@CE Load, save or delete a stored session
aviour
- Translation Saved Sessions
- Selaction Debug
- Colours
Default Settings
= Connection T
i [ seve |
roxy
o
Rlogin
[+ S5H
Seid Close window on exit:
(Mways ( Never @ Onlyon clean exi
| ot || Hep | [ open || Cancel

Figure 38. Terminal (PuTTY) configurations
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4. For Linux OS users only, run the following commands in your terminal. These install libudev onto your system, which
is required by KDS IDE to launch the debugger.

user@ubuntu:~$ sudo apt-get install libudev-dev libudevl

user@ubuntu:~$ sudo 1ln -s /usr/lib/x86_ 64-linux-gnu/libudev.so /usr/lib/x86 64-linux-

gnu/libudev.so.0

5. Ensure that the debugger configuration is correct for the target you’re attempting to connect to. Consult Appendix B for

more information about the default debugger application on the various hardware platforms supported by the KSDK.
a. To check the available debugger configurations, click the small downward arrow next to the green “Debug”

button and select “Debug Configurations”.

Wlora~®e v~

‘ (no launch history

Debug As

Debug Configurations... I

Organize Favorites...

Figure 39. Debug Configurations dialog button

b. Inthe Debug Configurations dialog box, select debug configuration that corresponds to the hardware platform

you’re using. In this example, since the FRDM-K64F is used, the interface to select is the CMSIS-DAP/DAPLink

option under OpenOCD. To determine the interface to use for other hardware platforms, refer to Appendix B.

After selecting the debugger interface, click the "Debug" button to launch the debugger.

% Debug Configurations

X B3
twpes el fet

| C/C== Application

| CfCan Bemote Application
GDE Hardware Debuggang
| GOE OpenOCD Debuggng

et e e Hem e e |

ol

Create, manage, and run configurations

CCe= Attach to Application
== Pestrnatem Debugger

Mame  hella_world_fedmbef dek

wg drmdasdap

|5} Man| BF Debugger | B+ Startup | B Sowrce| [ Common

ChCa» Application:
Debughell_world_frdmbbdf.elf

Progect:

¢ | hello world irdmidd! debug crenda
. | hello_ world_frdmifdf release omsisdap

hello_world_frdmbibdf

't | GDB PEMicro Intedace Debugging
o [T] GOB SEGGER F-Link Debugging
£ hello_world_frdrmifdf debug jlink
[T] hello_world_frdmkfdf release jlink
B Launch Group

Filter rrstched 15 of 15 Rems

_.'-'uuhiu-.. | S-talfl'._hqm...

Browse..

Build (if requingd) before lasnching

Build configuration:

Debug

| Select configuration using "C/C+ + Applicaton

Close

Figure 40. Selection of the debug configuration and debugger launch

6. The application is downloaded to the target and automatically run to main():
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‘tﬁ Debug - helle_world_frdmbkb4f/source/hello_world.c - Kinetis Design Studio - YW\ psPHome\DocumentshKDS

File Edit Source Refactor Mavigate Search Project ProcessorExpert RBun Window  Help

. BIISB ENRE BT N iR O

ﬁDEhUg i ;- W | j_%:’ o= 8
4 [t ] hello_world_frdmkfdf debug cmsisdap [GDB OpenOCD Debugging]
4 ._:,'ﬁ' hello_waorld_frdmbba4f.elf
4 f# Thread [1] (Suspended : Breakpoint)
= main{] at hello_world.c:57 0:1606

g openocd
g arm-none-eabi-gdb

[ hello_world.c &2

r _.'-:':!
* [@brief Main function
:-:.|.'

—int main (woid)

1
/{ RX buffers
J/V Iparam receiveBuff Buffer used to hold received data

uintd_t receiveBuft;
J// Initialize standard SDK demo application pins
hardware _init();

Figure 41. Stop at main() when run debugging

7. Start the application by clicking the "Resume" button:

| Resume (F8) |

Figure 42. Resume button

The hello_world application is now running and a banner is displayed on the terminal. If this is not the case, check your

terminal settings and connections.
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Figure 43. Text display of the hello_world demo

6 Run a demo using Atollic® TrueSTUDIO®

This section describes the steps to configure Atollic TrueSTUDIO to build, run, and debug demo applications and necessary
driver libraries provided in the KSDK. The hello_world demo application targeted for the FRDM-K64F Freedom hardware
platform is used as an example, though these steps can be applied to any demo or example application in the KSDK.

NOTE
The Eclipse update required for the KDS IDE toolchain is not required for Atollic.

6.1 Select the workspace location

The first time that TrueSTUDIO launches, it prompts the user to select a workspace location. TrueSTUDIO uses Eclipse,
which uses workspace to store information about its current configuration, and in some cases, source files for the projects in
the workspace. The location of the workspace can be anywhere, but it is recommended that the workspace be outside of the
KSDK tree.

6.2 Build the platform library

These steps guide you through the process of opening and building the platform library project in TrueSTUDIO. The
platform library is required by the demo and does not build without it.

1. Select “File -> Import” from the TrueSTUDIO menu. Expand the “General” folder and select “Existing Projects into
Workspace”. Then, click the “Next” button.
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Figure 44. Selection of the correct import type in TrueSTUDIO

2. Click the “Browse” button next to the “Select root directory:” option.

BElimpest o [E] 8
Import Projects T :
Select a directory to seanch for easting Echpse progects. ‘¢ ;r"‘
s =1
Select archve file - Brewae
Projects:
Sedect ANl
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—
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| Search fer nested projects
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Add project o working sels
@ [clok ] et o | [ Coneat ]

Figure 45. Projects directory selection window
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3. Point to the platform library project for the appropriate device, which can be found using this path:
<install_dir>/lib/ksdk_platform_lib/atl/<device_name>
For this example, the specific location is:
<install_dir>/lib/ksdk_platform_lib/atl/K64F 12

4. After pointing to the correct directory, your “Import Projects” window should look like this figure. Click the “Finish”
button.

E Imiport = = =
Import Projects e ol
Select & directory to search for existing Eclipse projects. ',/ ,l':
-

@ Select root directory:  C\Freescale’KSOHCL100VR ksdie_platferm_| -

Select archive file:
Prajects:
¥ ksdi_platforen_Eb_EB4F12 (C\Freescale S0 _1.1.00 0k ksl _platf: Sedect All
' Deselect Al

.Refrﬁ.h;

] -] ¥

Options
Zearch for nested projects
Copy projects sto workspace
Working sets
Add project to working sets

® o w Celees

Figure 46. Select the K64F12 platform library project

NOTE
Do not select the "Copy projects..." option.

5. There are two project configurations (build targets) supported for each KSDK project:
* Debug — Compiler optimization is set to low, and debug information is generated for the executable. This target
should be selected for development and debug.
* Release — Compiler optimization is set to high, and debug information is not generated. This target should be
selected for final application deployment.
6. Choose the appropriate build target, “Debug” or “Release”, by clicking the “Manage build configurations” icon, as
shown below. For this example, select the “Debug” target and click “Set Active”. Since the default configuration is to
use the Debug target, there should not be a change required.
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Figure 47. Selection of build target in TrueSTUDIO
7. Click the "Build" icon to build the library.

6.3 Build a demo application

To build a demo application, repeat the steps listed in section 6.2, using a demo application project instead of the platform
library project. Demo application projects are located in this folder:

<install_dir>/examples/<board_name>/demo_apps/<demo name>/atl
For this example, the path is:

<install_dir>/examples/frdmk64f/demo_apps/hello_world/atl

6.4 Run a demo application

The Atollic tools require either a J-Link or P&E Micro debug interface. As a result, some hardware platforms require an
update to the OpenSDA debug firmware found on the board. To determine the default debug interface of your board, see
Appendix B. If the default interface is not J-Link or P&E Micro, see Appendix C for instructions on how to install one of
these debug interfaces.

This section describes steps to run a demo application using a J-Link debugger, although the P&E Micro interface is also
supported.

In order to perform this exercise with the J-Link interface, two things must be done:

¢ Install the J-Link software (drivers and utilities), which can be downloaded from segger.com/downloads.html.
* Make sure that either:

* The OpenSDA interface on your board is programmed with the J-Link OpenSDA firmware. To determine if your
board supports OpenSDA, refer to Appendix B. For instructions on reprogramming the OpenSDA interface, refer
to Appendix C. If your board does not support OpenSDA, then a standalone J-Link pod is required.

A standalone J-Link pod is connected to the debug interface of your board. Note that some hardware platforms
require hardware modification in order to function correctly with an external debug interface.

The P&E Micro interface can also be used. To use this interface:
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¢ Install the P&E Micro Hardware Interface Drivers, which can be downloaded from www.pemicro.com/support/

downloads_find.cfm.

* If your board does not come loaded with a P&E Micro interface, if supported, reprogram the OpenSDA interface with

P&E Micro OpenSDA firmware. To determine if your board supports OpenSDA, refer to Appendix B. For instructions
on reprogramming the OpenSDA interface, refer to Appendix C.

For the MRB-KWO1 board, visit www.freescale.com/USB2SER to download the serial driver. This board does not support

OpenSDA, so an external J-Link is required.

After the debug interface is configured and ready to use, to download and run the application, perform these steps:

1. Connect the development platform to your PC via USB cable between the OpenSDA USB connector (may be named

OSJTAG for some boards) and the PC USB connector.

2. Open the terminal application on the PC, such as PuTTY or TeraTerm, and connect to the debug serial port number (to
determine the COM port number, refer to Appendix A). Configure the terminal with these settings:

a. 115200 or baud rate, depending on your board (reference BOARD_DEBUG_UART_BAUD variable in board.h

file)
b. No parity
c. 8 data bits
d. 1 stop bit
R PuTTY Configuration
Category:
=+ Session Basic options for your PuTTY session
i T." Lpgf;ing Specify the destination you want to connect to
= Termina
' Senal line Speed
- Keyboard e
- Ball COM16 115200
- Features onnection type:
= Window JRaw () Telnet () Rlogin () SSH | @ Seral
: Appea@ce Load, save or delete a stored session
Behaviour
. Translation Saved Sessions
Selection Debug
- Colours
Default Settings
= Comnection O —
e
rony
o
Rlogin
[+ S5SH
Serial Close window on exit:
) Mways Never @ Only on clean exit
[ fbou || Hb | Open || Cance

Figure 48. Terminal (PuTTY) configurations
3. Ensure that the debugger configuration is correct for the target you are attempting to connect to.
a. To check the debugger configurations, click the “Configure Debug” icon.
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RQRRK8G8| S

Figure 49. Debug configurations dialog button
b. In the Debug Configurations window, select debug configuration that corresponds to the hardware platform
you’re using. The Atollic tools require either a J-Link or P&E Micro debug interface, so some hardware
platforms require an update to the OpenSDA debug firmware. To determine the default debug interface of your
board, refer to Appendix B. If the default interface is not J-Link or P&E Micro, refer to Appendix C for

instructions on how to install one of these debug interfaces.

Important: This example assumes the J-Link interface has been installed on the FRDM-K64F Freescale

Freedom development board platform.

c. Select the J-Link “Debug” interface and click the “Debug” button.

E Debug Configurations
Create, manage, and run configurations

| -+
X EBEE&F-~
type filter tesd

[€] C/C++ Application
[E] C/C++ Attach to Application
[E] €/C++ Postrmgrtem Debugger
[€] C/Cs+ Remote Application
# [£] Embedded C/C++ Application
c | hello_world_frdmkf4f debug flink §
[t | hello_world_frdmkb4f debug pne
E] helle_world_framikbdf release jlink
£ ] hello_world_frdmid4f release pne
B Launch Group

Filter matched 10 of 10 items

.- ?\.

e

Name: hello_world_frdmiBdf debug jlink

C/C++ Application:
debug/hello_world_frdmiddf el

[] Main . %F Debugger| B Startup Scripts| 52 Source| 1 Common

! Variables... !i.Sear:hPrnject....i Browse.. |

hello_world_frdmiodf

Build (if required) before launching

Build configuration:

[ Salart ronfuncratinn nginn /0w« Snnlication’

Browse... |

[oew J( oo

Figure 50. Selection of debug configuration in Debug Configuration dialog box

4. The application is downloaded to the target and automatically runs to main():
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E Debug - hello_world_frdmbkbdf/source/hello_world.c - Atollic TrueSTUDIO® for ARME

File Edit View Run Window Help
D S BRI i@y O o~ 2|0~

%5 Debug &2 ¥ = B
4 [t ] hello_world_frdmk64f debug jlink [Embedded C/C++ Application]
4 1@ hello_world_frdmbk64f,elf
4 g Thread [1] <main> (Suspended : Breakpoint)
= main() at hello_world.c:57 0x1416
p gdb
g SEGGER J-LINK

lc] hello_werld.c 23

] '/ RX buffers
/4 @param receiveBuff Buffer used to hold received data
uintd t receiveBuff;

'/ Initialize standard SDK demo application pins
hardware _init(};

'/ Call this function to inditialize the console UART. This function
'/ enables the use of STDIO functions (printf, scanf, etc.)
dbg_uart_init();

Figure 51. Stop at main() when run debugging

5. Run the code by clicking the "Resume" button to start the application.

s6eE] snne B

Figure 52. Resume button

The hello_world application is now running and a banner is displayed on the terminal. If this is not the case, check your
terminal settings and connections.

Figure 53. Text display of the hello_world demo
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7 Run a demo using ARM® GCC

This section describes the steps to configure the command line ARM GCC tools to build, run, and debug demo applications
and necessary driver libraries provided in the KSDK. The hello_world demo application targeted for the FRDM-K64F
Freedom hardware platform is used as an example, though these steps can be applied to any board, demo or example
application in the KSDK.

7.1 Set up toolchain

This section contains the steps to install the necessary components required to build and run a KSDK demo application with
the ARM GCC toolchain, as supported by the KSDK. There are many ways to use ARM GCC tools, but this example focuses
on a Windows operating system environment. Though not discussed here, ARM GCC tools can also be used with both Linux
OS and Mac OSX.

7.1.1 Install GCC ARM Embedded tool chain

Download and run the installer from launchpad.net/gcc-arm-embedded. This is the actual toolset (i.e., compiler, linker, etc.).
The GCC toolchain should correspond to the latest supported version, as described in the Kinetis SDK v.1.2.0 Release Notes.
(document KSDK120RN)

7.1.2 Install MinGW

The Minimalist GNU for Windows (MinGW) development tools provide a set of tools that are not dependent on third party
C-Runtime DLLs (such as Cygwin). The build environment used by the KSDK does not utilize the MinGW build tools, but
does leverage the base install of both MinGW and MSYS. MSYS provides a basic shell with a Unix-like interface and tools.

1. Download the latest MinGW mingw-get-setup installer from sourceforge.net/projects/mingw/files/Installer/.
2. Run the installer. The recommended installation path is C:\MinGW, however, you may install to any location.

NOTE

The installation path cannot contain any spaces.

3. Ensure that the “mingw32-base” and “msys-base” are selected under Basic Setup.

B MinGW Installation Manager
Installation Package Settings

Basic Setup Package Class  Installed Version Repository Version  Description
All Packages . . . .
[ mingw-developer-taal... bin 2013072300 An M3YS Installation for MinGW Developers (meta)
mingw32-base bin 2013072200 A Basic MinGW Installation
I:‘ mingw32-gcc-ada bin 4.8.1-4 The GMU Ada Compiler
I:‘ mingw32-gcc-fortran bin 4.8.1-4 The GMU FORTRAN Compiler
D mingw32-gcc-g++ bin 4.8.1-4 The GNU C++ Compiler
|:| mingw32-gcc-objc bin 4.8.1-4 The GMNU Qbjective-C Compiler
msys-base bin 2013072300 A Basic MSYS Installation (meta)

Figure 54. Setup MinGW and MSYS

4. Click “Apply Changes” in the “Installation” menu and follow the remaining instructions to complete the installation.
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7 MinGW Installation Manager
Installation | Package Settings
Update Catalogue | Package
Mark All Upgrades ID mingw-developear-toal...
I Apply Changes ;El mingw32-base
] mingw32-gec-ada
Quit a+F4 [ mingw32-gce-fortran
‘] mingw32-gec-g++
E] mingw32-gcc-abjc
msys-base

Figure 55. Complete MinGW and MSYS installation
5. Add the appropriate item to the Windows operating system Path environment variable. It can be found under Control

Panel -> System and Security -> System -> Advanced System Settings in the "Environment Variables..." section. The
path is:

<mingw_install_dir>\bin

Assuming the default installation path, C:\MinGW, an example is shown below. If the path is not set correctly, the
toolchain does not work.

NOTE
If you have "C:\MinGW\msys\x.x\bin" in your PATH variable (as required by
KSDK 1.0.0), remove it to ensure that the new GCC build system works correctly.
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Systemn Properties &3
Computer Name | Hardware | Advanced | System Protection | Remate
F -
Environment Variables X
Edit System Varnable | 23 |
Variable name: Fath
Yariable value: agram Files (x8a)\CMake\bin; C: \MinGW ibin
| Ik | | Cancel |

System variables

Variable Value m
Q5 Windows_NT W
Path C:'Program Files (x8&)\Parallels\Parallel...
PATHEXT .COM;.EXE: .BAT:.CMD:.VBS;.VBE;.15;....
PROCESSOR_A... AMD&4 o
| Mew.. || Edit. || Delete
| oK | | Cancel

Figure 56. Add Path to systems environment

7.1.3 Add a new system environment for ARMGCC_DIR

Create a new system environment variable and name it ARMGCC_DIR. The value of this variable should point to the ARM
GCC Embedded tool chain installation path, which, for this example, is:

C:\Program Files (x86\GNU Tools ARM Embedded\4.8 2014q3
Reference the installation folder of the GNU ARM GCC Embedded tools for the exact path name of your installation.

Getting Started with Kinetis SDK (KSDK) v.1.2, Rev. 0, 4/2015

38 Freescale Semiconductor, Inc.




h o
g |

4
Run a demo using ARM® GCC

Environment Variables | 4 |

F

L
i &)

Mew Systern Vanable | &3 |

Variable name: ARMGCC_DIR

Variable value: C:YProgram Files (x86)\GMU Tools ARM Emb

| QK | | Cancel

System variables

Variable Value -
Qs Windows_NT W
Path C:\Program Files (x85)\Parallels\Parallel...
PATHEXT .COM;.EXE:.BAT:.CMD;.VBS;.VBE;.15;......
PROCESSDR._A... AMDG4 »
| Mew.. || Edit.. || Delete
| (04 | | Cancel

Figure 57. Add ARMGCC_DIR system variable

7.1.4 Install CMake

1. Download CMake 3.0.x from www.cmake.org/cmake/resources/software.html.
2. Install CMake, ensuring that the option "Add CMake to system PATH" is selected when installing. It’s up to the user to

select whether it’s installed into the PATH for all users or just the current user. In this example, the assumption is that
it’s installed for all users.
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A CMake 3.0.2 Setup o] @[]

Install Options
Choose options for instaling CMake 3.0.2

By default CMake does not add its directory to the system PATH.

Do not add CMake to the system PATH
@ Add CMake to the system PATH for all users
Add CMake to the system FATH Tor current user

[| Create CMake Desktop Icon

| <Back || mext> | | cancel |

Figure 58. Install CMake

3. Follow the remaining instructions of the installer.
4. You may need to reboot your system for the PATH changes to take effect.

7.2 Build the platform library

To build the platform library, follow these instructions:

1. Open a GCC ARM Embedded tool chain command window. To launch the window, from the Windows operating
system Start menu, go to “Programs -> GNU Tools ARM Embedded <version>" and select “GCC Command Prompt”.

. GMNU Tools ARM Embedded 4.5 201493
Documentation
GCC Command Prompt
ﬂ Uninstall GMU Tools for ARM Embec

Figure 59. Launch command prompt
2. Change the directory of the command window to the platform library directory in the KSDK:

<install_dir>/lib/ksdk_platform_lib/armgcc/<device_name>/

3. There are two project configurations (build targets) supported for each KSDK project:
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* Debug — Compiler optimization is set to low, and debug information is generated for the executable. This target

should be selected for development and debug.
* Release — Compiler optimization is set to high, and debug information is not generated. This target should be

selected for final application deployment.

There are batch files provided to build both configurations. For this example, the “Debug” target is built and

“build_debug.bat” is typed on the command line. If the “Release” target is desired, type the “build_release.bat” instead.

Alternatively, if using the command line is not desired, you can double click on the batch files from Windows
operating system Explorer.

B Administrator: GCC Command Prompt o || B[ ER

C:“Freescale~HSDK_1_2 _8~1lib“ksdk_platform_lib“~armgcc“~H64F12>build_debug._bat

Figure 60. Build debug version of platform library

4. When the build finishes, the outpout looks like the image below.

[18@:x 1 Built target KsdkPlatformLib

C:wFreescale~KSDKE_1.2.8~1lib~ksdk_platform_lib“armgcc~K64F12 pausze
Prezz any k to continue . . .

Figure 61. KSDK platform library build successful

5. The library (libksdk_platform.a) is generated in one of these directories, according to the build target:
<install_dir>/lib/ksdk_platform_lib/armgcc/<device_name>/debug

<install_dir>/lib/ksdk_platform_lib/armgcc/<device_name>/release

7.3 Build a demo application
KSDK demo applications require that the platform library for the same build target (Debug or Release) is present. Please
ensure that you follow the steps in section 7.2 prior to attempting to build a demo application.

To build a demo application, follow these steps.

1. If not already running, open a GCC ARM Embedded tool chain command window. To launch the window, from the

Windows operating system Start menu, go to “Programs -> GNU Tools ARM Embedded <version>" and select “GCC

Command Prompt”.

GMU Tools ARM Embedded 4.8 201493

Documentation
%5 GCC Command Prompt
_ﬁﬂ; Uninstall GMU Tools for ARM Embec

Figure 62. Launch command prompt
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2. Change the directory to the demo application project directory, which has a path like this:
<install_dir>/examples/<board_name>/demo_apps/<demo_name>/armgcc
For this example, the exact path is:
<install_dir>/examples/frdmk64f/demo_apps/hello_world/armgcc

3. Type “build_debug.bat” on the command line or double click on the "build_debug.bat" file in Windows operating
system Explorer to perform the build. The output is shown in this figure:

[188:x1 Built target hello_world

C:wFreezcale“KSDK_1 .2 _Bwexanplessfrdmkodfdemo_appz-hello_worldsarmgcc *pause
Prezs any k to continuwe . . .

Figure 63. hello_world demo build successful

7.4 Run a demo application

This section describes steps to run a demo application using J-Link GDB Server application. To perform this exercise, two
things must be done:

* Install the J-Link software (drivers and utilities), which can be downloaded from www.segger.com/downloads.html.
* Make sure that either:

* The OpenSDA interface on your board is programmed with the J-Link OpenSDA firmware. To determine if your
board supports OpenSDA, refer to Appendix B. For instructions on reprogramming the OpenSDA interface, refer
to Appendix C. If your board does not support OpenSDA, then a standalone J-Link pod is required.

* You have a standalone J-Link pod that is connected to the debug interface of your board. Note that some
hardware platforms require hardware modification in order to function correctly with an external debug interface.

After the J-Link interface is configured and connected, follow these steps to download and run the demo application:

1. Connect the development platform to your PC via USB cable between the OpenSDA USB connector (may be named
OSJTAG for some boards) and the PC USB connector. If using a standalone J-Link debug pod, also connect it to the
SWD/JITAG connector of the board.

2. Open the terminal application on the PC, such as PuTTY or TeraTerm, and connect to the debug serial port number (to
determine the COM port number, refer to Appendix A). Configure the terminal with these settings:

a. 115200 or 9600 baud rate, depending on your board (reference BOARD_DEBUG_UART_BAUD variable in
board.h file)

b. No parity

c. 8 data bits

d. 1 stop bit
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Category:
]+ Session Basic options for your PuTTY session |
i T'"' L.r.:g;g'rHQ Specify the destination you want to connect to
- :elmma Serial ine
- Keyboard Speed
- Bel COM16 115200
- Features nechon type:
= Window (VRaw () Telnet () Rlogin () SSH | @ Seral
ﬁppea. Load, save or delete a stored session
L Behaviour
L Translation Saved Sessions
. . Selection Debug
- Default
5 Comnection e —
o [ Seve |
- Rlogin
[+-5S5H
~ Sl Close window on exit:

 Mways ( Never @ Only on clean exit

[ aow || Hep | |_open || Camcel |

Figure 64. Terminal (PuTTY) configurations
3. Open the J-Link GDB Server application. Assuming the J-Link software is installed, the application can be launched by

going to the Windows operating system Start menu and selecting ‘“Programs -> SEGGER -> J-Link <version> J-Link
GDB Server”.

4. Modify the settings as shown below. The target device selection chosen for this example is the “MK64FN1MOxxx12”.
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[ SEGGER J-Link GDB Server V4.90a - Config £|
[~ Connection teJ-Link
* LSH [ Serial Mo
" TCPAP

i~ Target device

IlHKEd-FN‘IHOm-:‘IE l

|5|.|tt|e endian - |

Tatget interface

|SwD =
~ Speed

" Auto selection

 Aclaptive ]

&+ 1000 »| kHz

Command line opltion
|-selet:t LISE -device MEBAFM1MOx=x12 -f SWD -zpeed 1000

oK | Cancel |

Figure 65. SEGGER J-Link GDB Server configuration

5. After it is connected, the screen should resemble this figure:
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-~ 'y

E!SEGGEHJ-LinkGDE Server V4,903 | = || = || 28 |
File Help

v Localhost only
GDE |'W'aiting for cannection I Initial 5D zpeed |‘||:||:||:| kHz j [ Stay on top

[v Show log window

J-Link |Eu:unr‘n3n:te::| Current S''0 zpeed |'IEIEIEI kHz [~ Generate logfile
; ; [ Yerfy download
CPU |I'-1KE4FN'I b a1 2 | 2300 |L|ttle endian J 2 It regs on start
Log autput: Llear log |
Target interface speed: 1000kH= -
Target endian: little

Connecting to J-Link. ..

J—Linlk 1= connected.

Firmware: J-Link OpenSDA 2 compiled Apr 24 2014 14:44:11
Hardware: W1.00

S<H: 621000000

Checlking target woltage. . .

Target woltage: 3.30 V

Li=stening on TCP~IFP port 2331

1

Connecting to target . .  Connected to target
Waiting for GDE connection. . . il
Fi ¥

0 Bytes downloaded 1 JTAG device

Figure 66. SEGGER J-Link GDB Server screen after successful connection

6. If not already running, open a GCC ARM Embedded tool chain command window. To launch the window, from the
Windows operating system Start menu, go to “Programs -> GNU Tools ARM Embedded <version>" and select “GCC
Command Prompt”.

. GMU Toeols ARM Embedded 4.8 20143
Docurmnentation
45 GCC Command Prompt
_GEL Uninstall GMU Tools for ARM Embec

Figure 67. Launch command prompt
7. Change to the directory that contains the demo application output. The output can be found in using one of these paths,
depending on the build target selected:

<install_dir/examples/<board_name>/demo_apps/<demo_name>/armgcc/debug
<install_dir/examples/<board_name>/demo_apps/<demo_name>/armgcc/frdmk64f/release
For this example, the path is:

<install_dir>/examples/frdmk64f/demo_apps/hello_world/armgcc/debug
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8. Run the command “arm-none-eabi-gdb.exe <demo_name>.elf”. For this example, it is “arm-none-eabi-gdb.exe
hello_world.elf”.

BN Administrator: GCC Command Prompt - arm-none-eabi-gdb hello_world.elf = || B ER

C:wFreescale~KSDK_1 .2 . 8sexamples~frdmkbodf ~demo_appsshello_worldsarmgoccsdebug>arm
—none—eabi—gdb hello_world.elf

GMU gdbh (GWU Tools for ARM Embedded Processors> Y.6.0.20148731-—cus

Copuright <C» 2013 Free Software Foundation, Inc.

License GPLu3i+: GHU GPL version 3 or later <http:-sgnu.org-slicenses gpl.html>
Thiz iz free software: you are free to change and redisztribute it.

There is WO WARRAWIY. to the extent permitted by law. Type "show copwing'

and "show warranty' for details.

Thiz GDB was configured as "“"——hoszt=i686—wbd—mingw32 —target=arm—none—eahi'.

For bug reporting instructions,. please see:

“http:z swww._gnu.orgssof twaresgdh-bugs->. ..

Reading symbols from C:“Freescale~KSDK_1.2._ 8@examplez“frdmko4f-demo_apps~hello_uw
orld-armgccdebugs~hello_world.elf...done.

Cgdh?

Figure 68. Run arm-none-eabi-gdb

9. Run these commands:
a. "target remote localhost:2331"
b. "monitor reset"
¢. "monitor halt"
d. "load"
e. "monitor reset"

10. The application is now downloaded and halted at the reset vector. Execute the “monitor go” command to start the demo
application.

The hello_world application is now running and a banner is displayed on the terminal. If this is not the case, check your
terminal settings and connections.

Figure 69. Text display of the hello_world demo

8 Appendix A - How to determine COM port

This section describes the steps necessary to determine the debug COM port number of your Freescale hardware
development platform. All Freescale boards ship with a factory programmed, on-board debug interface, whether it’s based on
OpenSDA or the legacy P&E Micro OSJTAG interface. To determine what your specific board ships with, reference
Appendix B.

1. To determine the COM port, open the Windows operating system Device Manager. This can be achieved by going to
the Windows operating system Start menu and typing “Device Manager” in the search bar, as shown below:
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Control Panel (3)

|é Device Manager

@‘u’iew devices podomrint
Device Manager

a8 Update devid| yiew and update your hardware's settings and driver s
Pictures (9)

|| Companies.inc

|| hut.inc

|| PTPStillIrnageTables.inc
| VIDs_PIDs. TXT

|| SCSL_CDB_RevCpyRshs.inc
|| SCSL_CDB_SPC.inc

|| hei_command_table.inc
|| RNDIS_OIDuinc

|| CDCRequests.inc

Files (1)

= dialog_settings.xml

p See more results

| Device Manager b4 | | Shut down |

Figure 70. Device manager
2. In the Device Manager, expand the “Ports (COM & LPT)” section to view the available ports. Depending on the
Freescale board you’re using (refer to Appendix B), the COM port can be named differently:
a. OpenSDA — CMSIS-DAP/mbed/DAPLink interface:
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477 Ports (COM &L LPT)
P ? mbed Senal Port (COM41)
Figure 71. OpenSDA — CMSIS-DAP/mbed/DAPLink interface
b. OpenSDA — P&E Micro:
4 73" Ports (COM &L LPT)
Pl ? Open5DA - CDC Senal Port (http://www.pemicro.com/opensda) (COM22)
Figure 72. OpenSDA - P&E Micro
c. OpenSDA - J-Link:
4 75" Ports (COM &L LPT)
. .05 JLink CDC UART Port (COM12)

Figure 73. OpenSDA - J-Link
d. P&E Micro OSJTAG:

4. Ports (COM & LPT)

Figure 74. P&E Micro OSJTAG
e. MRB-KWOI1:

J"? Ports (COM & LPT)
P ? Freescale COC Device (COM49)

Figure 75. MRB-KWO01

9 Appendix B - Default debug interfaces

The Kinetis SDK supports various Kinetis hardware platforms that come loaded with a variety of factory programmed debug
interface configurations. The following table lists the hardware platforms supported by the KSDK, their default debug
interface, and any version information that helps differentiate a specific interface configuration.

All recent and future Freescale hardware platforms support the configurable OpenSDA standard.

Table 1. Hardware platforms supported by KSDK

Hardware platform Default interface OpenSDA details
FRDM-K22F CMSIS-DAP\mbed\DAPLink OpenSDA v2.1
FRDM-K64F CMSIS-DAP\mbed\DAPLink OpenSDA v2.0
FRDM-KL02Z P&E Micro OpenSDA OpenSDA v1.0
FRDM-KL03Z P&E Micro OpenSDA OpenSDA v1.0
FRDM-KL25Z P&E Micro OpenSDA OpenSDA v1.0
FRDM-KL26Z P&E Micro OpenSDA OpenSDA v1.0
FRDM-KL27Z P&E Micro OpenSDA OpenSDA v1.0

Table continues on the next page...
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Appendix C - Updating OpenSDA firmware
Table 1. Hardware platforms supported by KSDK (continued)

FRDM-KL43Z P&E Micro OpenSDA OpenSDA v1.0
FRDM-KL46Z P&E Micro OpenSDA OpenSDA v1.0
FRDM-KW24 CMSIS-DAP\mbed\DAPLink OpenSDA v2.1
MRB-KWO01 N/A External Probe Required N/A

TWR-K21D50M P&E Micro OSJTAG N/A

TWR-K21F120M P&E Micro OSJTAG N/A

TWR-K22F120M P&E Micro OpenSDA OpenSDA v1.0
TWR-K24F120M CMSIS-DAP\mbed OpenSDA v2.1
TWR-K60D100M P&E Micro OSJTAG N/A

TWR-K64F120M P&E Micro OpenSDA OpenSDA v1.0
TWR-K65F180M P&E Micro OpenSDA OpenSDA v1.0
TWR-KL43Z48M P&E Micro OpenSDA OpenSDA v1.0
TWR-KV10Z232 P&E Micro OpenSDA OpenSDA v1.0
TWR-KV31F120M P&E Micro OpenSDA OpenSDA v1.0
TWR-KV46F150M P&E Micro OpenSDA OpenSDA v1.0
TWR-KW24D512 P&E Micro OpenSDA OpenSDA v1.0

10 Appendix C - Updating OpenSDA firmware

Any Freescale hardware platform that comes with an OpenSDA-compatible debug interface has the ability to update the
OpenSDA firmware. This typically means switching from the default application (either CMSIS-DAP/mbed/DAPLink or
P&E Micro) to a SEGGER J-Link. This section contains the steps to switch the OpenSDA firmware to a J-Link interface.
However, the steps can be applied to also restoring the original image.

For reference, OpenSDA firmware files can be found at the links below:

» J-Link: Download appropriate image from www.segger.com/opensda.html. Chose the appropriate J-Link binary based
on the table in Appendix B. Any OpenSDA v1.0 interface should use the standard OpenSDA download (i.e., the one
with no version). For OpenSDA 2.0 or 2.1, select the corresponding binary.

* CMSIS-DAP/mbed/DAPLink: This interface is provided to support the ARM mbed initiative. Navigate to
developer.mbed.org/platforms and select your hardware platform. On the specific platform/board page, there is a link to
the firmware image and instructions on how to load it, though the instructions are the same as below.

* P&E Micro: Downloading P&E Micro OpenSDA firmware images requires registration with P&E Micro
(www.pemicro.com ).

These steps show how to update the OpenSDA firmware on your board for Windows operating system and Linux OS users:.

1. Unplug the board's USB cable.
2. Press the board's "Reset" button. While still holding the button, plug the board back in to the USB cable.
3. When the board re-enumerates, it shows up as a disk drive called "BOOTLOADER".
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Figure 76. BOOTLOADER drive

4. Drag the new firmware image onto the BOOTLOADER drive in Windows operating system Explorer, similar to how
you would drag and drop a file onto a normal USB flash drive.

NOTE
If for any reason the firmware update fails, the board can always re-enter
bootloader mode by holding down the "Reset" button and power cycling.

These steps show how to update the OpenSDA firmware on your board for Mac OS users.

1. Unplug the board's USB cable.

2. Press the board's "Reset" button. While still holding the button, plug the board back in to the USB cable.

3. For boards with OpenSDA v2.0 or v2.1, it shows up as a disk drive called "BOOTLOADER" in Finder. Boards with
OpenSDA v1.0 may or may not show up depending on the bootloader version. If you see the drive in Finder, you may
proceed to the next step. If you don't, you must use a Windows 7 or earlier PC to either update the OpenSDA firmware
or update the OpenSDA bootloader to version 1.11 or later. The bootloader update instructions and image can be
obtained from P&E Microcomputer website.

4. For OpenSDA v2.1 and OpenSDA v1.0 (with bootloader 1.11 or later) users, drag the new firmware image onto the
BOOTLOADER drive in Finder, similar to how you would drag and drop the file onto a normal USB Flash drive.

5. For OpenSDA v2.0 users, type these commands in a Terminal window:

> sudo mount -u -w -o sync /Volumes/BOOTLOADER
< ¢cp -X <path to update file > /Volumes/BOOTLOADER

NOTE
If for any reason the firmware update fails, the board can always re-enter
bootloader mode by holding down the "Reset" button and power cycling.

11 Revision History

This table summarizes revisions to this document.
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Revision History

Table 2. Revision History

Revision number Date Substantive changes
0 04/2015 KSDK 1.2.0 release
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